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For your convenience, make a hard copy of this file, and keep the pages handy.

1. About PhotoStudio Version 2.0
==============================

ArcSoft PhotoStudio v2.0 is a full featured, 32-bit digital imaging program for 
consumers and professionals.  PhotoStudio provides novice and professional users 
with a complete set of easy-to-use photo editing and retouching tools, as well as a 
wide selection of special effects and enhancements with unlimited levels of 
modification and thumbnail previews.  Special features include: 

·    Complete set of editing and retouching tools like air brush, bucket fill, paint 
brush and more

·    Over 40 special effects and enhancements with unlimited levels of modifications 
and real-time, thumbnail preview windows

·    ArcSoft’s exclusive Album Manager, an image database that provides easy file 
searching, drag-and-drop arranging and multiple file retrieving

·    Unique slide show creation with descriptive text and over 100 transition effects 
·    Multiple output options including full-color, black-and-white, grayscale images 

and slide shows for publication, presentation or animation



·    Support for TWAIN-compliant scanners and digital cameras
·    Support for most major file formats including BMP, TIF, JPG, GIF, PCD, PCX, 

TGA, EPS and FlashPix 
·    Support for Photoshop plug-ins 

2. System Requirements 
======================

· 486-based PC 
· Windows 3.1x, 95, 98 or NT
· 8 MB of RAM
· 6 MB free hard disk space
· CD-ROM drive for installation
· VGA monitor w/16-bit color display
· Mouse 

To achieve the best performance, ArcSoft recommends the following: 

· Pentium-based PC
· 16 MB (or more) of RAM
· 8 MB (or more) free hard disk space
· VGA monitor w/24-bit color display

Supports:  
·    Popular image formats including BMP, TIF, JPG, GIF, PCD (read only), PCX, 

TGA, EPS (write only) and FlashPix 
·    TWAIN-compliant devices
·    Canon, Epson, Hewlett-Packard, Lexmark and other popular printers

3. Win32s for Win 3.1x Users
==========================

Windows 3.1x is a 16-bit operating system, and PhotoStudio is a 32-bit program. To 
install a 32-bit program on a 3.1x computer, you will need Microsoft Win32s installed on 
your system first.  For your convenience, Win32s is included on your PhotoStudio CD.  
You may also download the latest Win32s version from Microsoft’s web site at 
www.microsoft.com.

To install Win32s, insert the PhotoStudio CD in your CD-ROM drive.  From 
Program Manager, click File/Run and type D:\win32s\Setup.exe (where “D” is 
your CD-ROM drive) and click OK. 

4. Register Your Software  
========================



Register your software to qualify for free technical support and upgrade 
information from ArcSoft. To access the built-in registration form: Windows 95, 98 or 
NT users, go to Start/Programs/ArcSoft PhotoStudio/Register & Upgrade. Windows 3.1x 
users, click the Register & Upgrade icon from the PhotoStudio program group. Please fax
the completed form to 1-510-440-1270 or mail it to the following address:

ArcSoft, Inc.
Attn: Customer Service
46601 Fremont Boulevard
Fremont, CA 94538

ArcSoft Imaging Suite users: Please refer to the ReadMe documentation enclosed in the
Imaging Suite.

5. Contacting ArcSoft
====================

For questions relating to customer service or ArcSoft, please refer to the “Main” contact 
numbers below.  For questions relating to technical support issues, the ArcSoft website 
(www.arcsoft.com) is a great technical resource that contains helpful tips and hints, 
FAQ’s and downloads.  You may also contact Technical Support at the numbers listed 
below.  Please remember to register before contacting us.  To give you the best possible 
customer support, please provide the following information: 

1. Your contact information (name, email or mailing address, phone number)
2.   The name and serial number of the product
3. A description of the problem
4. A verbatim description of the error message, if any
5. The operating system (Windows 3.1x, 95, 98 or NT)
6. Any other hardware devices you have installed

Main:
ArcSoft, Inc. M-F: 8:30 AM - 5:30 PM (PST)
46601 Fremont Blvd. Phone: 1-800-762-8657
Fremont, CA 94538 Fax: 1-510-440-1270
USA Email: feedback@arcsoft.com

Technical Support:
Phone: 1-510-440-9901 M-F: 8:30 AM – 5:30 PM (PST)
Fax: 1-510-440-1270 Email: support@arcsoft.com

Websites:
www.arcsoft.com
www.zipshot.com



www.photoisland.com

6.        ArcSoft Web Services
======================

With PhotoStudio, you have a direct link to ArcSoft’s extended Web Services. In Web
Services, you can click into your choice of helpful ArcSoft services, such as tips and 
technical support. You’ll find it’s easy to stay in touch with ArcSoft!

·    Windows 95, 98 and NT users: Click Start/Programs.  Go to the ArcSoft 
PhotoStudio menu and click Web Services.

·    Windows 3.1x users: From your Program Manager, click File/Run. Select the 
program group titled PhotoStudio and double-click on Web Services. 

·    ArcSoft Imaging Suite users: Please refer to the ReadMe documentation enclosed
in the Imaging Suite.

7. Setting the Virtual Memory in Win 3.1x 
====================================

Note:  If you are running Windows 95, 98 or NT, use the default memory settings.

The more RAM that is available to run PhotoStudio, the larger the image you can 
successfully manipulate, and the better performance you can obtain. It is essential to set 
the virtual memory in your system to the specified amount (depending on the size of the 
RAM and available hard disk space). 

Follow the instructions below to set the virtual memory:
1.   From your Program Manager, go to the Main group and double click on the Control 

Panel icon.
2.   Double click on the 386 Enhanced icon.
3.   In the 386 Enhanced dialog box, click on the Virtual Memory button.
4.   In the Virtual Memory dialog box, click on the Change button to expand the dialog 

box.
5.   Go to the Drive list box and select the drive that has the most available space in your 

system.
6.   Go to the Type list box and select Permanent.
7.   Go to the New Size editing box and enter the same value as shown in Recommended 

Maximum Size.
8.   Click OK to activate your new setting and close the dialog box.

8.  Using Windows Explorer or File Manager to Open Images 
==================================================



By double-clicking on any file in Windows Explorer or File Manager, you can launch the 
program associated with that particular file format, along with the file.  In Windows, this 
is called File Association.  For example, if you double-click on an image file, 
PhotoStudio will launch, along with the image.  If you find that a different program 
(other than PhotoStudio) opens, you can change the File Association settings in Windows 
so that specific file types open with specific programs.  Here are instructions on 
associating image files with PhotoStudio.  (For more detailed information on “File 
Association” or “Associating Files” consult your Windows manual.)

Win 95, 98 and NT users: 
1.   Open Windows Explorer and click once on an image file (e.g. JPG)
2.   While holding down your shift key, right-click on the file. 
3.   Select "Open With" from the menu. 
4.   Choose Other… 
5.   Locate the Pstudio.exe file and double-click on it. 
6.   Make sure the "Always Use This Program..." checkbox is checked.
7.   Select OK. Now whenever you click on a file of this type, PhotoStudio will open 

automatically.

Win 3.1x users: 
1.   Start File Manager and Select File: Associate.
2.   Type in the file type you would like to associate with PhotoStudio (JPG for

example). 
3.   Click Browse.
4.   Locate the Pstudio.exe file and double-click on it.
5.   Click OK from the Associate window. Now whenever you click on a file of this type, 

PhotoStudio will open automatically.

9. Using Online Help 
====================

PhotoStudio has an easy-to-use online Help interface that can be accessed by either 
clicking on the Help menu or the F1 key.  Online Help provides many options to enable 
you to quickly and easily learn about the program.

To use general help, click on Help from the Menu Bar.  Choose between such options as 
Index, Keyboard, Commands, Procedures or Tools and Palettes. To search for a category 
or topic, simply click on the Search button.  You can either type in the first few words of 
the topic you are interested in, or scroll through an entire list of topics.  Once you’ve 
chosen your topic, simply click on the Display button.

To use the context-sensitive help, go to the dialog box or menu item in question and 
then press the F1 key. 



For example, to see online Help on the Slide Show command, pull down the File 
Menu, highlight the Slide Show command without releasing the mouse button, 
and press F1 (while still holding the mouse button down). The online Help 
window will appear, with the information on the Slide Show command already 
displayed. This lets you get directly to the topic you want without having to 
search through the help topics and subtopics.  

10. Installing Photoshop Plug-In filters 
================================

PhotoStudio supports Photoshop Plug-In filters for image import, export and special 
effects. When started, PhotoStudio will first search all the *.8ba (for import), *.8be (for 
export), and *.8bf (for effects) files in its PLUGINS subdirectory, and then the directories
shown in the entry of the PluginDir1, PluginDir2, and 3 etc. in the PSTUDIO.INI file that
is located in the Windows directory. If any of these types of files installed in the 
PLUGINS directory are identified in the path entry in the PSTUDIO.INI file, the Import, 
Export, and Plug-In Filters submenu will appear in the File and Effects menu 
respectively, and the filters are listed. Some plug-ins may not be compatible with 
PhotoStudio.  Please consult the plug-in manufacturer in those instances.

11.  Digital Camera and Scanner Support 
==================================

PhotoStudio supports digital cameras and scanners that are 100% compatible with 
TWAIN interface standard for image acquisition. In PhotoStudio, click on Acquire 
from the File Menu to open the TWAIN interface dialog box.  For information on setting 
up your TWAIN digital camera or scanner, refer to that devices documentation. If you did
not receive a TWAIN driver with your camera or scanner, contact the manufacturer 
directly. 

If your device supports multiple image acquiring and you would like to turn on this 
feature, you may add an entry MultiScan=1 in the USER section of PSTUDIO.INI 
located in Windows directory. If your scanner only support memory scan mode, you 
should add an entry MemoryScan=1 in PSTUDIO.INI.  After modifying PSTUDIO.INI, 
remember to save it.

12. File Format Support
=====================

PhotoStudio supports standard variations of the following image file formats: BMP, 
TIF, JPG, GIF, PCD, PCX, TGA, EPS and FlashPix.  However, if you find that one of 
your images does not open, it may be an uncommon variation that PhotoStudio does not 



support. If this is the case, try opening the file with the software that created it. Save the 
file in a common file format.

13. Display Quality 
=================

There are a few common questions from novice users when they enter the world of 
digital imaging.  One question concerns how the computer monitor displays the original 
or edited image.  The other question concerns Print Quality, which is discussed in Section
14.  Although there are variable factors to consider when working with digital imaging, 
we provide some specific information that we hope you find helpful. 

·    Monitor Setting.  Monitors have specific settings that interpret the data from your 
image file. Its capability to view color depends on many conditions including how 
you select your monitor settings. We have provided a few recommendations to 
enhance your viewing capacity.

Windows 95, 98 or NT users: Your Windows display should be set on High Color or 
True Color.  (From the Start menu, select Settings/Control Panel.  Double-click on 
Display, then click on the Settings tab.)  If you do not have High Color/16-bit or True 
Color/24-bit, then use 256-color mode. Image and template quality will be lower on 
this setting.

Windows 3.1x users: Run Windows setup to change color setting.  For details, we 
recommend you contact your system or video card vendor for help in changing video 
mode.

·    Image File Formats.  Another important factor that can affect your displayed 
image is the file format you choose for saving and storing your image file. It is 
important to review their specific functions below to appreciate how they may affect 
what you view on your monitor.  A file format refers to the way data in an image file 
is stored on your computer. As the name implies, they are formats and therefore 
produce different results and serve different functions. The format you choose may 
affect your original and edited images, which in turn affects what you view on your 
monitor and printout. We recommend you review general digital imaging literature 
for further information.  The following provides a quick overview.

PhotoStudio supports the following image file formats: BMP, TIF, JPG, GIF, PCD 
(read only), PCX, TGA, EPS (write only) and FlashPix (FPX).

BMP is a widely used format in Microsoft Windows and its applications.  It is a good 
selection for saving an image when you still want to perform additional editing later. 
Although this will be a large file, you can always save it later under a different file 
format.



TIF (or TIFF) format is the Tagged Image File Format.  This works well for 
transferring images between different computers and is widely used in the printing 
industry.

JPG (or JPEG) is considered a standard for image compression. This compressed file 
helps to free up storage space. You can control the rate of compression depending on 
how much image information you can sacrifice. The higher quality compressed image
you want, the less compression you can get. It is capable of retaining millions of 
colors. It is typically used for storing edited images and is a common format used on 
web pages, as the compressed file is much quicker to download.

GIF is the Graphics Interchange Format developed by Compuserve.  This is an 
excellent format to use for sending graphics to the web and transferring files between 
different types of computers or over data lines, because it can minimize transfer time. 
This format can support up to 8-bit resolution.  Note that this format only saves and 
views images in 256 colors, even if you have your computer set to 24-Bit color.  
Therefore, if your original image contained more colors, they will not be retained.  
This format does not support 24-Bit True Color.

PCD is the Photo-CD format developed by Kodak.  Images in this format are usually 
compressed on a compact disc and have several different resolutions available. This 
format is used for desktop publishing and can be read (but not saved) in PhotoStudio.

PCX is a standard format used by many IBM PC programs.  It was originally 
designed by Zsoft for its PC Paintbrush program.

TGA (or TARGA) format was developed by True Vision, a maker of video boards.  
Several painting and image enhancement programs use this format.

EPS (or Encapsulated PostScript) is a format used for desktop publishing and can be 
saved (but not read) in PhotoStudio.  

FPX (or FlashPix) was developed by Eastman Kodak, Hewlett Packard, Microsoft 
and Live Picture Inc. It offers three levels of resolution and uses JPG compression.

14.  Print Quality 
================

Another common digital imaging question concerns print quality. While there are 
variable factors involved, here are a few items to consider.  

·    Printer Settings.  Like your monitor, your printer has specific settings that print 
data from your image file depending on the selected settings and system capability. 
More and more printers on the market provide special options and control functions 
for printing graphics. Printer manufacturers typically provide extensive information 



about operating the settings. 

·    Paper Quality.  Paper quality can make a significant difference to your printout 
(e.g. the smoother surface gives higher quality).  For optimal print quality, take 
advantage of the special paper designed for printing graphics.

·    File Formats.  Another important factor that affects your printed image includes 
the file format you choose for saving and storing your image file. (See Section 13 
“Display Quality –Image File Formats”)

15. Tips When Using PhotoStudio
=============================

Keep your computer’s memory uncluttered.  To free up memory, close the images 
you are not working with. Close any windows that you do not need. Having a window 
open will take up memory space.  This will decrease the amount of available memory that
PhotoStudio has to perform tasks on your active window.

Clear the Clipboard image or replace it with a smaller one if you will not use it any more.
Images kept on the Clipboard will also take up space and slow down PhotoStudio.

If you are only working on a small part of the picture, make sure that area is 
selected.  Not only will you speed up PhotoStudio, you will also protect the parts of the 
picture that you do not want to change.

Even if you are working with the entire image, try editing a small part of the image first.  
Once you are sure of the edits you want to make, you can go back and modify the entire 
image.  This is an especially helpful technique when you are applying complex effects or 
filters which take a long time for PhotoStudio to perform.

If a process does not work, there may be a small select area. Even if you cannot see a 
marquee, there may be a select area that is too small to see, or it may be in part of your 
image that is not currently on the screen.

To eliminate the possibility that there may be a select area, click on the image screen with
the Select tool, or press Delete key.  After you do this, the process should begin to work 
on the entire image correctly.

If a command does not seem to be available, the image may be required to be in 
either 24-bit color or 8-bit grayscale data type. For example, the Blur and Sharpen 
functions, and the functions in the Effects menu work only with 24-bit color and 8-bit 
grayscale images. You can check your image data type from either the “Image 
Information” command or read from the Status Line (at the bottom of the program 
windows). To transfer an image data type from one to another, use the Convert 
commands.



16.  Copyright of Sample Image Files
===============================

The sample image files installed by PhotoStudio 2.0 are the property of ArcSoft, Inc. or 
their respective companies and are not intended for commercial use or distribution. 

17.  End User License Agreement
============================

The following is a legal software license agreement between you, the software end user, 
and ArcSoft, Inc.  Carefully read this license agreement before using the product.  Using 
the product indicates that you have read this license agreement and agree to its terms.
If you do not agree to the terms of it, promptly return the product package to the place 
where you purchased it within 10 days of the date you acquired it for a full refund.

Grant of License. This license permits you to use one copy of the software included in 
this package on any single computer.  For each software licensee, the program can be in 
use on only one computer at any given time. The software is in use when it is either 
loaded into RAM or installed into the hard disk or other permanent memory. 
A multi-seat license permit from ArcSoft is required if the program is going to be 
installed on a network server for the sole purpose of distribution by other computers, or if
the program is going to be installed on and used by more than one computer.

Copyright. The software contained in this package is owned by ArcSoft and is protected 
by United States copyright laws, international treaty provisions, and all other applicable 
national laws. The software must be treated like all other copyrighted materials (e.g. 
books and musical recordings). This license does not allow the software to be rented or 
leased, and the written materials accompanying the software (if any) may not be copied.

Limited Warranty. ArcSoft, Inc., warrants that the software contained herein will 
perform substantially in accordance with the accompanying documentation.
No Other Warranties.  ArcSoft disclaims all other warranties, either express or implied, 
including but not limited to implied warranties of merchantability and fitness for a 
particular purpose, with respect to the Software, the accompanying written materials, and 
any accompanying hardware (if any).

No Liability for Consequential Damages.  In no event shall ArcSoft or its suppliers be 
liable for any damages whatsoever (including but not limited to damages for loss of 
business profits, business interruption, loss of business information, or any other 
pecuniary loss) which results from an inability to use this software, even if ArcSoft, Inc. 
has been advised of the possibility of such damages.  Because some states/jurisdictions 
do not allow the exclusion or limitation of consequential or incidental damages, the above
limitations may not apply to you.



U.S. Government Restricted Rights. The Software and documentation are provided 
with Restricted Rights.  Use, duplication, or disclosure by the U.S. Government is subject
to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and 
Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1),(2), and (3) 
of the Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as 
applicable, and any amendments thereto.  The manufacturer is ArcSoft, Inc., 46601 
Fremont Blvd., Fremont, CA 94538.

If this product was purchased in the United States, this Agreement is governed by the 
laws of the state of California; otherwise, local laws may apply.

18. Year 2000 Compliance Statement
===============================

1. Representations that Software is Year 2000 Compliant

1.1 General Representation.  ArcSoft, Inc. represents that all
ArcSoft Software is designed to be used prior to, during, and after
the calendar  year  2000 A.D,  and that  the  Software  will  operate
during each such time period without error relating to date data,
specifically including any error relating to, or the product of, date
data which represents or references different centuries or more than
one century.

1.2 Specific Representations. Without limiting the generality
of the foregoing, ArcSoft, Inc. further represents:

1.2.1  The Software will not abnormally end or provide invalid or 
incorrect results as a result of date data, specifically 
including date data which represents or references different 
centuries or more than one century. The Software has been 
designed to ensure year 2000 compatibility, including, but 
not limited to, date data century recognition, calculations 
which accommodate same century and multi-century 
formulas and date values, and date data interface values 
that reflect the century.

1.2.2 The Software includes "Year 2000 Capabilities." For the 
purposes of this Agreement, "Year 2000 Capabilities" 
means the Software: (i) will manage and manipulate data 
involving dates, including single century formulas and 
multi-century formulas, and will not cause an abnormally 
ending scenario within the application or generate incorrect
values or invalid results involving such dates; (ii) provides 



that all date-related user interface functionality and data 
fields include the indication & century; and (iii) provides 
that all date-related data interface functionality includes the
indication of century.

2.       Modification of Software;  Limitations on Representations

2.1 Software Modifications and Combinations. 
Notwithstanding, anything in Section 2 above, ArcSoft, Inc. makes
no representations regarding the Software being Year 2000 
Compliant to the extent any failure of the Software to be Year 2000
Compliant is caused by any modification of the Software by any 
third party or any combination of the Software with any other 
software programs not approved for use with the Software by 
ArcSoft, Inc.

2.2 No Other Representations or Warranties. EXCEPT AS 
EXPRESSLY PROVIDED HEREIN OR IN THE LICENSE 
AGREEMENT, ARCSOFT, INC. MAKES NO OTHER 
WARRANTIES, EITHER EXPRESS OR IMPLIED, 
REGARDING THE SOFTWARE, ITS MERCHANTABILITY OR
ITS FITNESS FOR ANY PARTICULAR PURPOSE.

3. Limitation of Liability And Damages

3.1 Limitation of Liability. IN NO EVENT SHALL 
ARCSOFT, INC. BE LIABLE FOR ANY COSTS OF 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, 
LOSS OF USE OR INTERRUPTION OF BUSINESS, LOST 
PROFITS OR ANY CONSEQUENTIAL, SPECIAL, 
INCIDENTAL, OR INDIRECT DAMAGES OF ANY KIND 
UNDER ANY CAUSE OR ACTION (INCLUDING 
NEGLIGENCE), WHETHER OR NOT THE PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
THESE LIMITATIONS SHALL APPLY NOTWITHSTAND1NG 
THE FAILURE OF THE ESSENTIAL PURPOSE OF ANY 
LIMITED REMEDY.

3.2 Limitation of Damages. ARCSOFT, INC'S TOTAL LIABILITY 
FOR DAMAGES IN CONNECTION WITH THIS STATEMENT, 
WHETHER IN AN ACTION IN CONTRACT OR TORT OR 
ANY OTHER FORM OF ACTION, WILL IN NO EVENT 
EXCEED THE TOTAL AMOUNT OF PAYMENTS ACTUALLY 
PAID FOR THE SOFTWARE AT THE TIME OF PURCHASE.

4. Additional Provisions



4.1 Jurisdiction. The parties agree that all disputes arising 
among them related to this statement, whether arising in contract, 
tort, equity or otherwise, shall be resolved only in the United States
Federal Courts in the Northern District of California or California 
State Courts located in Santa Clara County, California. Each party 
hereby waives any disputes it may have with respect to proper 
venue.

4.2 Legal Expenses.  The prevailing party in any legal action
brought  by  one  party  against  the  other  and  arising  out  of  this
statement  shall  be  entitled,  in  addition  to  any  other  rights  and
remedies it may have, to reimbursement for its expenses, including
court costs and reasonable attorneys' fees.

4.3 Governing Law. The validity, construction and enforceability of 
this statement shall be governed in all respects by the law of 
California; it shall be applicable to agreements negotiated, 
executed and performed in California between California 
corporations, whether one or more of the parties shall be or 
hereafter become a resident of another state or country, and 
without reference to conflict of laws principles.

4.4 Amendment. This statement may be amended or modified only in 
a written document signed by an authorized representative of 
ArcSoft, Inc.

Copyright 1994-1998 by ArcSoft, Inc. All rights reserved.
PhotoStudio is a trademark of ArcSoft, Inc.
All other brands or product names are trademarks or registered trademarks of their respective holders.


